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Book - 1

Chapter - 1 Introducing Computers

Assessment

1. Write ‘Yes’ or ‘No’ for the following statements :
a. Yes b. No c. Yes d. No e. Yes f. No

2. Tick (v) the right option :
Do it yourself.

3. Circle the correct spelling :
a. (iii) b. (i) e. (iD)

Chapter - 2 Parts of a Computer
Activity
Match the following columns :
1. Remember the things 2. Write the letters 3. Watch the world 4. Smell the food
Assessment
1. Write ‘Yes’ or ‘No’ for the following statements :
a. Yes b. No e¢. No d. Yes e. Yes
2. Fill in the blanks :
a. brain b. monitor e. keys d. mouse
3. Fill in the boxes with the name of the part of computer :
a. KEYBOARD b. MOUSE e¢. MONITOR d. CPU
4. Who am I?
a. MOUSE b. MONITOR c¢. KEYBOARD d. CPU
5. Label the parts of a computer :
MOUSE, MONITOR, CPU, KEYBOARD

Chapter - 3 Computer Maintenance

Assessment

1. Fill in the blanks :
a. careful b. eat, drink c. sitting posture d. delicate e. CPU

2. See the pictures below. If it shows the correct way to use a computer, put a tick
(v’) in the box. If it shows the wrong way put a cross (X) :
Do it yourself.

3. Write ‘Yes’ or ‘No’ for the following statements :
a. No b. Yes c. Yes d. No e. Yes

4. Tick (v) the correct option :
a. (iil) b. (iii) e. (i)

Chapter - 4 Fun With Paint

Activity

Page no. - 32

Arrange the following steps in proper order to open the ‘Paint’ screen :
451->3->2

Activity

Page no. - 34

Do it yourself.
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Assessment
1. Fill in the blanks :
a. make drawings b. draw and paint c. select the colour d. fill the colour
2. Match the following columns :
Do it yourself.
3. Write the various steps to open ‘MS Paint’.

To open MS Paint : (a) click on Start button. (b) Click on All Programs. (¢) click on Accessories
(d) Click on Paint.

4. Write down the various used of ‘MS Paint’.
(a) Use to make posters. (b) Used to make greeting cards.

5. Name the various components of screen in the following diagram :
Do it yourself.

Chapter - 5 Introduction to WordPad
Activity
Page no. - 42
1. Fill in the blanks :
a. WORDPAD b. NOTEBOOK c¢. KEYBOARD d. COMPUTER
Activity
Page no. - 44
Do it yourself.
Assessment
1. Write down the steps to open Word Pad.
(a) Click on start button (b) Click All Programs (¢) Go To Accessories (d) Click on WordPad.
2. Fill in the blanks :
a. notebook b. WordPad e. pencil d. keyboard e. Enter f. Spacebar key
3. Match the following :
Do it yourself.

Model Test Paper - 1
A. Tick (v) the correct option :

1.a2.a3.a4.a5.b6.b7.a8.a9.b10.a11.a12.213.b14.b15.a216.b17.a18.a
19. a 20.

Model Test Paper - 11

A. Tick (v) the correct option :
1.b2.b3.a4.b5.2a6.a7.b8.a9.b10.a11.b12.a13.a

B. Answer the following questions :

1. To open MS Paint : (a) click on Start button. (b) Click on All Programs. (¢) click on Accessories
(d) Click on Paint. 2. (a) Use to make posters. (b) Use to make greeting cards. 3. (a) Click Start
button (b) Click All Programs (c) Go to Accessories (d) Click on WordPad.

C. Match the following columns :
Do it yourself.
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Book - 2

Chapter - 1 Computer Fundamental
Activity
Page no.-6
Do you think you are different from computer? Write ‘Yes’ or ‘No’ against the
following questions :
a.Y,Nb.Y,Ye.Y,Nd.N,Ye.Y,Nf. Y, N
Activity
Page no. - 8
Match the following columns :
1.d2.c3.b4.a
Assessment
1. Fill in the blanks :
a. electronic b. stores e¢. Desktop d. decisions e. Palmtop
2. Write Yes or No for the following statements :
a. No b. Yes e¢. No d. Yes
3. Complete the following steps :
shut, Monitor, CPU, Power, UPS
4. Tick (v) the correct option :
a. (ii) b. (i) e. () d. ()
5. Think of three things that you can do but a computer cannot :

I can A computer
1. eat and sleep 1. cannot eat and sleep
2. do mistakes 2. cannot do mistakes
3. make decisions 3. a computer cannot take decisions

Chapter - 2 Uses of Computer

Activity

Page no. - 16

Tick (v’) the correct option :
1.c2.c3.a

Activity

Page no. - 19

Match the following columns :

1.c2.d3.a4.b

Activity

Page no. - 21

1. Diseases 2. Bridges 3. Designing 4. Satellites

Assessment

1. Fill in the blanks :
a. banks b. designing e. ATM d. schools e. movies

2. Write Yes or No for the following statements :
a. No b. Yes e¢. Yes d. No

3. What are the uses of Computer in hospitals :
(a) Used by the doctors in operations. (b) Used for medical tests. (¢) used for diagnosing diseases.
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4. Identify the places in the following pictures and write down the uses of computer
used in these places :

Hospital : (a) Used by the doctors in operations. (b) Used for medical tests. (¢) Used for
diagnosing diseases.

Airport : (a) Used to inform about arrival and departure. (b) For reservation. (¢) Keeping a
record of all passengers.

School : (a) Used by teachers to explain lessons. (b) To prepare report card. (¢) To keep record
of students.

Chapter - 3 Computer Keyboard and Mouse
Assessment
1. Fill in the blanks :
a. mouse b. wireless ¢. drop d. Enter e. Spacebar
2. Write Yes or No for the following statements :
a. Yes b. Yes c¢. No d. No e. No
3. Write the names of keys shown in red :
a. Caps lock key b. Spacebar key e. Backspace key d. Enter key e. Delete key
4. Match the following columns :
1.d2.e3.b4.a5.c
5. Tick (v) the correct option :
a. (i) b. (iii) e. () d. (ii)

Chapter - 4 More Fun With Paint
Assessment
1. Give one word for the following :
a. Drawing area b. Text tool c. Pencil tool d. Eraser tool e. File-Exit
2. Write down the steps for saving the drawing :
(a) Click on File option. (b) Click on Save (¢) Type the File name (d) Click the Save button.
3. Arrange the steps into correct order for opening the saved drawing :
Step 1 : Click the File which you want to open.
Step 2 : Click the File option. A menu appears.
Step 3 : Click the Open option for the list. A new window appears.
Step 4 : Click the Open button.
4. Write Yes or No for the following statements :
a. Yes b. No c. No d. Yes
5. Write down the steps in given drawing for using the Brush :

1. Go to Home tab 2. Click the Brush tool 3. Select any shape. 4. Select a colour from colour group
5. Drag the brush in Drawing Area.

Chapter - 5 More on WordPad

Activity

Page no. - 47

Complete the following steps to open WordPad :
Click Start button.

Click All programs.

Click WordPad.
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Activity
Page no. - 51
Complete the following steps to save a WordPad file :
Click WordPad
Click Save
Type the name of file
Click Save button.
Activity
Page no. - 53
Match the following columns :
1.c2.b 3.d4.a
Assessment
1. What is WordPad?
WordPad is a Program used for typing text on a computer.
2. Write down the steps to open a WordPad file?
(a) Click WordPad button. (b) Click the Open option. (¢) Select the file. (d) Click Open button.
3. Fill in the blanks :
a. text b. Save ¢. WordPad button d. Ribbon e. tabs, groups
4. Write Yes or No for the following statements :
a. Yes b. No ¢. No d. No e. Yes
5. Unscramble the following jumbled letters :

1. programs 2. option 3. window 4. devices 5. pictures 6. notepad 7. 8. ribbon 9. toolbar
10. actions

6. Name the parts of WordPad window :
Do it yourself.

Model Test Paper - I
A. Tick (v) the correct option :
1.b2.23.b4.b5.a
B. Fill in the blanks :
1. drop 2. movies 3. designing 4. electronic 5. store
C. Write Yes or No for the following statements :
1. Yes 2. No 3. No 4. Yes 5. Yes
D. Answer the following questions :
1. (a) Used by the doctors in operations. (b) Used for medical tests. (¢) Used for diagnosing

diseases.

2. Ican A computer

1. eatand sleep 1. cannot eat and sleep
2. do mistakes 2. cannot do mistakes
3. make decisions 3. cannot take decisions

E. Write the name of keys shown in red :

a. Caps lock b. Spacebar e. Backspace d. Enter e. Delete
F. Complete the following steps :

Do it yourself.

Model Test Paper - II
A. Tick (v) the correct option :
1.a2.a3.b4.b5.a
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Fill in the blanks :

1. Save 2. text 3. tabs, groups 4. WordPad button 5. ribbon
Write Yes or No for the following statements :

1. Yes 2. No 3. Yes 4. Yes 5. No

Answer the following questions :

1. (a) Click on File option. (b) Click on Save (¢) Type the file name (d) Click the Save button.
2. (a) Click on WordPad button. (b) Click the Open option. (¢) Select the file. (d) Click Open
button.

Match the following columns :
1.c2.b3.d4.a
Write down the steps in given drawing for using the brush :

1. Go to Home tab 2. Click the Brush tool 3. Select any shape. 4. Select a colour from colour group
5. Drag the brush in Drawing Area.
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Book - 3

Chapter - 1 Computer Fundamental : Introduction of Hardware and Software

Activity

Page No. -7

1. Microwave 2. Dirty clothes 3. Ice-cream

Activity

Page No. - 10

Match the fo owing columns :

1.d2.c3.a4.b

Activity

Page No. - 13

Give one word for the following :

1. Speakers 2. Brushes 3. Joystick 4. Word Processing Software

Assessment

1. Tick (v) the correct option :
a. (i) b. () e. (iD)

2. Identify which one is hardware and software among the following :
a. Hardware b. Software e. Software d. Software e. Hardware

3. Answer the following questions :

a. In processing a computer accepts examines and calculate the result. b. (i) Paint Software - to
draw and colour pictures (ii) Music and video player - to listen the songs and watch movies.
c. Computer works with the help of IPO cycle (Input, Processing, Output) 5 + 3 Input —
Processing— 8 output. d. Input devices are used to enter data or give instructions to the computer

system. Eg. keyboard, mouse etc.

4. Match the following columns :
a. (i) b. (iii) e. (iv) d. (i)

5. Label the parts of computer system :
Monitor, Speakers, Mouse, CPU, Keyboard, Printer

Chapter - 2 MS Windows 7 : Operating System
Activity

Page No. - 18

Name any two operating systems :

DOS, UNIX

Activity

Page No. - 21

Identify the following parts of the Windows 7 desktop and write their names in the

given spaces :

1. START BUTTON 2. DATE AND TIME 3. SYSTEM TRAY 4. ICONS
Activity

Page No. - 23

Match the following columns :

1.d2.c3.a4.b

Activity

Page no. - 26

Do it yourself.
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Activity
Page No. - 28
Open calculator and find the results of the following :
1. 1030 2. 233 3. 2750 4. 319
Assessment
1. An operating system is a program that helps us to communicate with the computer. 2. Desktop is a
screen that appears on the monitor when the computer is ready to work. 3. Icons, Start button,
Taskbar, System Tray
4. Fill in the blanks :
a. title b. icon e. desktop d. Operating System e. Recycle bin
5. Write Yes or No for the following statements :
a. Yes b. No ec. Yes d. No

Chapter - 3 Advance Paint
Activity
Page No. - 33
Name the following tools :
1. Pencil 2. Fill with colour 3. Shapes (rectangle) 4. Shapes (oval)5. Eraser
Activity
Page No. - 39
Match the following columns :
1.d2.c3.24.b
Assessment
1. Fill in the blanks :
a. clipboard b. magnifier e¢. copy d. curve e. Select
2. Write Yes or No for the following statements :
a. No b. Yes e. Yes d. No
3. Guess the tool of the following :
a. Shape Tool b. Magnifier Tool e. Fill with color d. Eraser e. Select Tool
4. Write the steps to open the Paint program :
(i) Click Start button (ii) Click All Programs (iii) Click Accessories (iv) Click MS Paint

Chapter - 4 Microsoft Word : An Introduction
Activity
Page No - 49
1. Arrange the following steps to select a line :
STEP 2 : Click the mouse and drag the mouse over the line to select it.
STEP 1 : Move the cursor to the beginning of the line.
2. Fill in the missing step for saving the file :
STEP 2 : Click on Save option.
STEP 4 : Click on Save button.
Assessment
1. Fill in the blanks :
a. word processing b. title c. Ruler d. tab, group e. cursor
2. Write Yes or No for the following statements :
a. No b. Yes e. No d. Yes e. Yes
3. MS Word is a popular word processing software which helps us in creating and editing documents.
4. Editing means making corrections or changes in a document to ensure that it is correct.
5. a. (iii) b. (i) e. (iv) d. Ribbon
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Chapter - 5 Introduction to LOGO

Activity

Page No - 55

Arrange the following steps to open the MSW LOGO.
STEP 3 : Click on Microsoft Windows LOGO.

STEP 1 : Click on Start.

STEP 2 : Click on All Programs.

Activity

Page no. - 60

Do it yourself.

Activity

Page No. - 62

Write the output for each of the following :
1.75 2.5 3. PROGRAMMING IS EASY 4. 900 5. 59
ASSESSMENT

1.

2.

u

Fill in the blanks :

a. LOGO b. triangle c. input d. BYE e. text or numbers
Write Yes or No for the following statements :

a. No b. Yes e. No d. No e. Yes

Match the following columns :

a. (iv) b. (iii) e. (v) d. (i) e. (vi) f. (ii)

Language of Graphic Oriented.

(a) To draw figures and objects. (b) To perform calculations.
Mark and name the parts of LOGO window.

Do it yourself.

National Cyber Olympiad - Sample Paper

1.b2.a3.b4.b5.a6.b7.2a8.2a9.b10.a11.212.213.b14.b15.216.217.218.a19.b
20.b

Model Test Paper - [

A.

B.

Tick (v’) the correct option :

1.b2.b3.a4.b5.a

Fill in the blanks :

1. Clipboard 2. Select 3. Input 4. Operating System 5. Recycle bin

Write Yes or No for the following statements :

1. No 2. Yes 3. No 4. No 5. Yes

Answer the following questions :

1. (i) Click Start button (ii) Click All Programs (iii) Click Accessories (iv) Click MS Paint 2. In
processing, a computer accepts, examines and calculated the result. 3. Input devices are used t
enter data or give instructions to the computer system. Eg. Keyboard, mouse etc. 4. Desktop is a
screen that appears on the monitor when the computer is ready to work.
5. An operating system is a program that helps us t communicate with the computer. Human— OS
— Computer.

Match the following columns :
1. (ii) 2. (iii) 3. (iv) 4. (i)
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F. Guess the tools for the following :

a. Shape Tool b. Magnifier Tool e. Fill with colour Tool d. Eraser Tool e. Select Tool
G. Label the part of computer system :

Do it yourself.

Model Test Paper - II

A. Tick (v) the correct option :
l.a2.a3.a4.a 5.c

B. Fill in the blanks :
1. BYE 2. triangle 3. application 4. tab, group 5. cursor

C. Write Yes or No for the following statements :
1. No 2. Yes 3. Yes 4. No 5. No

D. Answer the following questions :
1. Language of Graphic Oriented. 2. MS Word is a popular word processing software which helps
us in creating and editing documents. 3. Editing means making corrections or changing in a
document to ensure that it is correct. 4. (a) To draw figures and objects. (b) To perform
calculations. 5. To make a square in LOGO : Type FD 100, RT 90, FD 100, RT 90, FD 100, RT 90,
FD 100, RT 90.

E. Match the following columns :
1. (iv) 2. (iii) 3. (v) 4. (i) 5. (vi) 6. (i)

F. Write down the uses of following command buttons :
1. To run the command written in Input Box 2. Shows the current settings. 3. Helps to clear the
output screen.

G. Mark and name the part of LOGO Window :
Do it yourself.
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Book - 4

Chapter - 1 Compute Memory and Storage

Activity

Page No. -6

Write down the different names of the following :

1. Main memory 2. Volatile memory 3. Non volatile memory

Activity

Page No. -9

Hard disk, Memory card, Pen drive

Assessment

1. Answer the following questions :
a. Computer memory is the place where information is stored. It is made up of chips. b. The two
types of memory are (i) Primary Memory (ii) Secondary Memory ¢. CD - (i) It can store upto 750
MB Data (ii) It can be played in DVD player. DVD - (i) It Can store upto 5 GB data. (ii) It cannot
be played in DVD player. d. Primary memory is used to store data and instructions. It can be
directly accessed by CPU. e. RAM is temporary memory in which programs, application and data
are stored. It is also known as volatile memory. ROM is memory that cannot be changed by a
program or a user. It is a Non-volatile memory.

2. Fill in the blanks :
a. bit b. Mega Byte c. Pen drive d. RAM, ROM e. RAM

3. Write ‘Yes’ or ‘No’ for the following statements :
a. Yes b. No e¢. No .d. No e. No

4. Match the following columns :
a. (i) b. (iv) e. (i) d. (iii)

5. Give one word for the following :
a. Blue Ray Disc Player b. Memory card ¢. USB Flash Drive d. CD e. Hard Disk

Chapter - 2 Working with MS Windows 7

Activity

Page No. - 15

Name the following components of windows explorer :

1. Navigation Buttons 2. Address Bar 3. View Button 4. Details Pane 5. Help

Assessment

1. Answer the following questions :
a. A windows explorer contains various narration tools and buttons. It helps in navigating from
one location to another to view and manage files and folders present in various drives and folders.
b. Libraries are collections where your music, videos, and pictures are stored and can be easily
accessed through the Desktop search function. e. Copy and paste file or folder makes multiple
copies of a file or folder. d. To create a new folder : (i) Select the folder or drive in the windows
explorer in which new folder is to be created. (ii) From the top bar select ‘New Folder’ option.
(iii) Provide the name to your folder. (iv) Press Enter Key.

2. Fill in the blanks :
a. navigation tool b. delete e. Indexing d. four e. drives, folders

3. Write ‘Yes’ or ‘No’ for the following statements :
a. No b. Yes e. No d. No e. Yes

4. Give below is a windows explorer screen. Mark all places give below :
Do it yourself.
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Chapter - 3 Editing and Formatting in MS Word 2007
Activity

Page no. - 24

Write the shortcut commands for the following :

Ctrl + C, Ctrl + X, Ctrl + V

Assessment

1.

Answer the following questions :

a. Changing and arranging text in a document is called formatting a document. It can be done by
using font group and paragraph group on Home tab. b. Clipboard, Font, Paragraph and Styles are
the group present on the ribbon of the Home tab. ¢. Alignment - Alignment is the way by which
the text is placed on a page. A text can be aligned in four ways. They are : Left alignment, Center
alignment, Right alignment and Justified. Left alignment : Left alignment means text is lined up
along the left margin. Right alignment : Right alignment means text is lined up along the right
margin. Center alignment : Center alignment means text is lined up around the midpoint.
Justified : It means text is lined up along both the left and right margins. d. To copy and paste
within the same document. (i) Select the text (ii) Click the Home tab (iii) Click Copy from
clipboard group. (iv) Move the cursor to desired location (v) Click Paste from the clipboard. e. If
we want to change any word or text with another word or tent, we use Find and Replace
feature. f. Undo command is used to cancel a command given earlier. Redo command is used to
reverse the action of Undo.

Fill in the blanks :

a. editing b. four e. Ctrl + V d. reverse the action of UNDO e. symbol f. Home

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes e. No d. Yes e. No f. Yes

Answer the following in one word :

a. Alignment b. Underline e. Font d. Cut

Recognise the icons given below and mention their group names :

a. Paste, Clipboard b. Bold, Italic, Underline, Font e. Font color, Font d. Highlight, Font e. Bullets,
Paragraph

Chapter - 4 LOGO Commands

Activity

Page no. 42

Give the color code of following colors :

Orange — 14, Blue —» 1, White — 7, Yellow — 6, Brown — 8, Green — 10

Assessment

1.

14

Answer the following questions :

a. The Pen Up or PU command lifts up the pen of the turtle. This lets the turtle move without
drawing a line. Pen Erase command makes the turtle work as an eraser and erase the line by
moving the turtle over it. b. Looping is the term to performing the same work again and again
until the desired output is obtained. In LOGO, we use the REPEAT command for looping. The
REPEAT command saves a lot of time as the command is give only once along with Syntax of
REPEAT command. e. To correct mistakes in LOGO, click on the command from the recall list box.
It will be displayed in the input box. Correct the command and execute it again. d. HT Command is
used to make the turtle disappear from the monitor where as ST Command is used to make the
turtle reappear on the monitor.

Fill in the blanks :

a. CT b. Pen down c. SET PC
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3. Give the full form of following :
a. Pen Down b. Pen Erase c. Forward d. Clear Text e. Clear Screen f. Hide Turtle g. Show Turtle
h. Right i. Left j. Pen Up

4. Write ‘Yes’ or ‘No’ for the following statements :
a. Yes b. No e¢. No d. No e. No

5. Correct the commands :

a. REPEAT 3 (PR [LEARNING LOGO IS FUN]) b. REPEAT 5 (FD 45 RT 60 ) e. PU d. REPEAT 20
(FD 3RT 2)

Chapter - 5 LOGO Procedures

Activity

Page No. - 50

Write down the rules of naming a procedure :

1. Always start with a letter. 2. Do not include arithmetic operations. 3. Do not include LOGO

command names. 4. Number and symbols can be included.

Activity

Page No. - 50

Arrange the following steps to create a procedure :

1. Click Edall button, then an editor window appears. 2. Type the name of the procedure after the

word ‘to’ 3. Type the commands between the word ‘to’ and ‘end.’

Activity

Page No. - 51

Write a procedure to draw a circle and save it on the computer :

To circle

Repeat 360 (FD 1 RT 1)

end

Activity

Page No. - 57

Write down the commands for following :

1. PRINT SUM 50 20 2. Label (1AM A CITIZEN OF INDIA) 3. PRINT REMAINDER 25 7 4. PRINT 200<

100 PRINT 150=150

Assessment

1. Answer the following questions :
a. The Procedure is a step-by-step sequence of doing an activity. For example : The Procedure to
start a LOGO program is: Click Start button — All Programs — Microsoft windows LOGO.
b. Arithmetic Functions in LOGO are : (i) Sum : This is used to add two numbers. PRINT SUM
<NUM 1> <NUM 2> (ii) Difference : This is used to subtract two numbers. PRINT DIFFERENCE
<NUM 1> <NUM 2> (iii) Product : This is used to multiply two numbers. PRINT PRODUCT
<NUM 1> <NUM 2> (iv) Quotient : This is used to divide a number to another number PRINT
QUOTIENT <NUM 1> <NUM 2> (v) Remainder :- This is used to show remainder when one
number is divided by another. PRINT REMAINDER <NUM 1> <NUM 2> c. Label Command is
used to print the text or number on the current location of the turtle as present on the screen.
d. The steps to load a procedure are (i) Click File menu. (ii) Click Load option. Open dialog box
appear. (iii) Click the file you want to open. (iv) Click Open button. e. You should save a
procedure so that it could be used later and need not be written again and again.

2. Fill in the blanks :

a. to b. Edall e. Label d. editor e. commands
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3. Write ‘Yes’ or ‘No’ for the following statements :
a. No b. Yes c. Yes d. Yes e. Yes
4. Write the print command to calculate the following :
a. PRINT SUM 45 60 b. PRINT DIFFERENCE 9999 3893 e¢. PRINT PRODUCT 34 40 d. PRINT
QUOTIENT 650 45
5. Find out which one is correct procedure name :
c. To ST34A6RT

Chapter - 6 And Introduction to MS Power Point

Activity

Page No. - 61

Write the names of all the Tabs and the groups in each tab present in PowerPoint :
TABS GROUPS

Home Clipboard, Slides, Font, Paragraph, drawing
Insert Tables, Illustrations, Links, Text, Media clips
Design Themes, Variants, Customize

Animation Preview, Animation, Advanced, Animation
Slide Show Start slide show, Set up, Monitors

Activity

Page No. - 65

Arrange the steps to insert a picture in a correct order :

1. Click on the insert tab. 2. In the [llustrations group, click on Picture. 3. The insert picture dialog box
appears. 4. Locate the picture that is to be Inserted and then click on insert button.

Assessment
1. Answer the following questions :

a. Microsoft PowerPoint is a presentation graphics software developed by Microsoft Company.
b. To create a new presentation :- (i) Click on the Office button. (ii) Click on New option.
Presentation dialog box will open. (iii) Blank presentation is selected by default. (iv) Click on
Create button. e. Place holders are the boxes with dotted outlined which appear when you create a
new slide. d. A series of slides displayed in sequence is called a slide show. e. Clipart allows to
insert images into the slides.

2. Fill in the blanks :
a. MS PowerPoint b. slides e. presentation d. title e. .ppt
3. Write ‘Yes’ or ‘No’ for the following statements :
a. No b. No c. Yes d. Yes e. No
4. Give one word for the following :
a. Clip art b. Slide e. .ppt d. Quick Access Toolbar e. Notes pane
5. Label the following on the given PowerPoint screen :
Do it yourself.

Chapter - 7 Multimedia and Internet

Activity

Page No. - 72

Find out which one is used for multimedia system :
CD-ROM, Headphone, Microphone, Monitor, Speakers
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Assessment

1.

Answer the following questions :

a. Multimedia is a type of computer software that combines text, sound, graphics and video.
b. Components (i) Sound Card and speakers for producing sound. (ii) Colour monitor to display
video. (iii) Microphone and headphone for recording and listening to sound. (iv) Multimedia CD
ROM to play CD/DVD. e. (i) Educational purposes (ii) Playing games. (iii) Playing music and
movies (iv) Imparting training to students and workers. (v) Creating advertisements, movies,
games, etc. d. Internet stands for international network of computers. We can get information on
any topic using internet. e. A Web Browser is a special software application or program that allows
you to access all the information available on the web. Examples of browsers are Microsoft
Internet Explorer, Mozilla Firefox, Google Chrome, Opera, etc. The steps to open a web browser :
STEP 1 : Click on Start. STEP 2 : Click on All programs. STEP 3 : Click on Internet Explorer.
Fill in the blanks :

a. Internet b. Uniform Resource Locator e. inserted d. web browser e. movies listen to songs
f. browser

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes c. Yes d. Yes e. No f. Yes

Match the following columns :

a. (v) b. (iv) e. (iii) d. (i) e. (ii)

Name the following :

a. Website b. URL e. Web browser d. Search engine e. International Network of Computer
f. E-mail

Model Test Paper
1.c2.a3.b4.¢c5.¢6.c7.2a8.b9.c10.a11.212.c13.c14.a15.¢c 16.b17.a18.c19.a20.a
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Book - 5

Chapter - 1 Evolution of Computers

Activity

Page no.-6

Match the following year with their invention of calculating devices :

1. Leibniz calculator 2. Abacus 3. Pascaline calculator 4. Napier’s bones

Activity

Page no. -9

Match the following columns :

1. Automatic digital computer used for numeric calculations 2. Perform all arithmetic operations
3. Handle both the numbers and text data 4. Program storing machine 5. Prepare mathematical tables
6. Tabulated statistics from millions of pieces of data 7. Capable to solve computer device

Activity

Page no. - 11

Match the following columns :

1.c2.d3.b4.a

Assessment

1. Answer the following questions :
a. Charles Babbage is, known as ‘Father of Modern Computers’ because today’s modern computer
works on the same principal as that the Analytical Engine. b. Third Generation - (i) IC’s were
used (ii) It was costly and not easily available. (iii) Eg: 1BM 360 Honey well 6000. Fourth
Generation - (i) VLSI technology is used. (ii) It was not so costly and became easily available to
people as PC. (iii) Eg: DEC 10, STAR 1000. c. Mark I was the first automatic digital computer
used for numeric calculation. It was capable to perform three calculations in a second. ENIAC was
designed by John Mauchly and J. Presper Eckert. It was the world’s first general purpose electronic
digital computer. d. Difference Engine - (i) It can do few mathematical calculations. (ii) It
forms the basis of analytical engine. Analytical Engine - (i) It can perform all arithmetic
operations. (ii) It forms the basis of modern computers that we use today. e. The following
changes were brought in second generation of computers as compared to the previous generation.
(i) Transistors were used instead of vacuum tubes. (ii) They were smaller in size, consumed less
electricity, worked faster and generated less heat.

2. Fill in the blanks :
a. Artificial Intelligence b. mechanical e. Mark I d. first e. transactions

3. Write ‘Yes’ or ‘No’ for the following statements :
a. No b. No c. Yes d. Yes e. Yes

4. Match the following columns :
a. (iv) b. (iii) e. (v) d. (i) e. (iv)

5. Name the given figures :
a. Napier’s Bones b. Pascaline Calculator e. Analytical Engine d. Integrated chips

Chapter - 2 More on MS Word 2007
Assessment
1. Answer the following questions :

a. To insert symbols in a document, follow the steps : STEP 1 : Place the cursor at the position
where you want to insert a symbol. STEP 2 : Click on the Symbol button in the Symbols group
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on the Insert tab. Select more symbols option. STEP 3 : The symbol dialog box appears. Select
the symbol tab, if it is not selected. STEP 4 : Select the font of your choice from the drop down list.
For example, wingdings. STEP 5 : Choose the symbol and click Close button to close the box.
b. A document can be made more attractive with pictures or photos. This can be done using the
following steps : STEP 1 : Click on Insert tab —Illustrations group — Picture option STEP
2 : An Insert Picture dialog box appears. Here, you may browse or type the location of the picture
on computer. STEP 3 : Select the desired picture. Click on the Insert button. e. A style is a
predefined combination of font style, colour and size of text that can be applied to selected text.
Follow the steps to apply built in style - Step - 1 Select the text. Step - 2 Click the more drop
down arrow from the style group. Step - 3 Click on the ‘styles’ dialog box launcher button.
Step - 4 Choose the required style. The text will change according to the style selected. d. (i)
Word Art - It allowed to create special text effects. (ii) Shapes - It is a drawing feature that
helps us to draw different shapes like stars, banners, callouts etc. e. There are five types of cases
available in MS Word, namely : Sentence case : The first character of each sentence is
capitalised. Lower case : All the character’ are small letters. Upper case : All the characters
are capital letters. Capitalise each word : The first character of every word is a capital letter.
Toggle case : Changes the upper case into lower case and vice-versa.

Fill in the blanks :

a. pictures b. Insert c. five d. Shape fill e. Word Art
Write ‘Yes’ or ‘No’ for the following statements :
a. Yes b. Yes c. Yes d. No e. Yes

Give one word for the following :

a. Upper Case b. Smart Art e. Text Box d. Clip Art e. Style
Match the following columns :

a. (iv) b. (iii) e. (v) d. (i) e. (i)

Chapter - 3 Creating Tables in MS Word 2007
Activity

Page no. - 30

Step - 1 Click on the Insert tab.

Step - 2 Click on the Table button and them click ‘Draw Table’.

Assessment

1.

Answer the following questions :

a. We use tables to preset text, information, numerical data or images in a tabular form. The steps
to insert a table in a document using a grid is as follows : STEP 1 : Click at the position where you
want to inset a table. STEP 2 : Click on Insert tab. STEP 3 : In the Tables group, click the Table
option. STEP 4 : The insert table grid appears. Drag the mouse to highlight the desired number of
rows and columns. STEP 5 : Click the left mouse button. You will see that an empty table gets
inserted in a document. b. To change the column width, use the end handle to decreased or
increase the width of the column. e. Auto fit option offers flexibility to automatically resize the
column width based on the size of the text in them. d. Combining more than one cell of a same
row or column is called merging. e. Deleting Rows and Columns : Step - 1 Select the row or
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column. Step - 2 Right click the mouse and a menu appears. Step - 3 Select Delete columns or
Delete Rows.

Fill in the blanks :

a. rows, columns b. Auto fit c. split cells d. Quick tables e. Layout

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes c. No d. Yes e. No

Give one word for the following :

a. Table b. Row ¢. Draw Table d. Cell

Match the following columns :

a. (i) b. (iii) e. (iv) d. (i)

Chapter - 4 Working with MS PowerPoint 2007
Activity
Page no. - 50

Match the following columns :
1.e2.d3.a4.b5.¢

Assessment

1.

Answer the following questions :

a. The different ways to create a new present ation in MS-PowerPaint are : 1. Blank and Recent 2.
Installed themes 3. New from Existing 4. Installed templates 5. My tamplates b. To change the
slide layout, follow the given steps : STEP 1 : Click the slide whose layout has to be changed.
STEP 2 : Click Home tab. STEP 3 : Now, click Layout from the slides group. STEP 4 : Choose the
layout you want from the various options displayed. e. Graphics can be used to make a
presentation more interesting. Depending on the topic, sometimes graphics can be more
informative than words. d. MS PowerPoint presentation facilitates you to view, your presentation
in various ways. The three main views are Normal View, Slide sorter view and slide show view. e.
Select the slide where the sound file or a movie file has to be inserted.

Click on Insert tab — media clips group — movie/sound drop down list.

Fill in the blanks :

a. Insert b. slide sorter view e. Normal view d. Layout e. saved

Give one word :

a. Slides View b. 9 c. Installed themes d. Blank and Recent template

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes c. Yes d. Yes e. No

Match the following columns :

a. (iv) b. (ii) c. (i) d. (v) e. (i)

Chapter - 5 Animations and Transitions
Activity
Page no. - 57

Write down all the options present in Animation Tab :

1. Preview 2. Animation 3. Advanced Animation 4. Timing
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Assessment

1.

Answer the following questions :

a. Animations are effects that make the objects of a slide as text, images, etc., move, appear or
disappear. Two animation effects are : (i) Entrance Animation : It determines the manner in
which any object appears on a slide eg : fade, Blinds. (ii) Exit Animation : It determine the
manner in which any object disappears from a slide eg : - Blinds, Peek out. b. Transitions are
effects that are in place when we switch from one slide to the next. A slide transition is how one
slide appears after the other on screen during slide show. Follow the steps to apply transition
effect : STEP 1 : Click the Animations tab. STEP 2 : Select the transition scheme. The slide
transition options will appear. Choose the options. STEP 3 : Adjust the transition speed if you
want the slide to advance automatically, check the automatically check box and set the number of
seconds. . When designing a presentation, the presenter needs to remember the following rules :
Rule 1 : The PowerPoint is a Map for your presentation. Rule 2 : Use 7x7 formatting while
formatting the bullet points for your presentation remember the 7x7 rule. There should be no
more than 7 words in the statement. Rule 3 : Proper Layout is Easy on the Eyes. A cluttered slide
is difficult to read. d. STEP 1 : Select the text of object on the slide you wish to modify. STEP 2 :
Select the Animations Tab. STEP 3 : Click Custom Animation in the Animations group. The
custom animation pane will appear on the right. Step 4 : Select the animation in the custam
animation task pane list, if it is not already selected. Step 5 : Click Remove. e.Transitions will
shw how slide will move from one slide to another where as Animations will show how objects on
a slide will move.

Fill in the blanks :

a. Animation b. Exit e. four d. mouse click e. presentations

Write ‘Yes’ or ‘No’ for the following statements :

a. Yes b. No e¢. No d. Yes e. No

Match the following columns :

a. (i) b. (iii) e. (iv) d. (i)

Give one word for the following :

a. Custom Animation b. Entrance and Exit ¢. Transition to this slide

Chapter - 6 Algorithm and Flowchart
Activity
Page no. - 62

Write an algorithm on the following :

1.

2.

Prepare a Mango Shake

STEP 1 : Start

STEP 2 : Put and cut a mango.

STEP 3 : pour milk, mango, sugar in the Mixergrinder.
STEP 4 : Switch ON the Mixergrinder.

STEP 5 : Switch OFF the Mixergrinder.

STEP 6 : Pour contents in a glass.

STEP 7 : Stop

Addition of two numbers

STEP 1 : Start

Drag and Drop 1 to 5 21



STEP 2 : Input Number 1
STEP 3 : Input Number 2
STEP 4 : Add the Two Numbers
STEP 5 : PRINT the result

STEP 6 : Stop
Activity
Page no. - 67

Convert the above given example of flowchart into algorithm.
STEP 1 : Start

STEP 2 : Input Number 1

STEP 3 : Input Number 2

STEP 4 : Check if Number 1 is greater than Number 2

STEP 5 : If the answer is Yes, Print Number 1

STEP 6 : If the answer is No, Print Number 2

STEP 7 : Stop

Assessment

1.

Answer the following questions :

a. Start / Stop Box - It is used to indicate the start and the end of the flowchart. Input /
Output Box - It is used to accept the input and deliver the output. Process Box - It is used for
processing. Decision Box - It is used when the condition of ‘Yes’ or ‘No’ arises. Flow Lines - It is
used to connect the different boxes of the flowchart with each other. b. There are some guidelines
for writing an algorithm : (i) It always starts with the START. (ii) Give a line number to each
instruction. (iii) Write each instruction in a separate line. (iv) Function of each statement needs
to be very clear. c. Guidelines for making a Flowchart : (i) Flowchart should have only on START
and on STOP box. (ii) The direction of flowchart is from top to bottom and left to right. (iii)
Arrowheads are used to indicate the sequence of event. (iv) Crossing flow lines do not show any
logical connection between those lines. (v) Only one flow line should come out from Process box.
(vi) If a flowchart is very complicated, it is better to use connectors. (vii) The flowchart should be
clear, neat and easy to follow. d. A program is a set of instructions give to a computer to solve any
problem. e. Algorithm is a sequence of steps followed in a logical order, written in simple English
to solve any problem and Flowchart is a pictorial form of sequence of steps to solve a problem
using symbols.

Fill in the blanks :

a. top, bottom b. Algorithm e. flowchart d. Output Box e. Flow lines

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes e. No d. Yes e. No

Match the following columns :

a. (i) b. (iii) c. (v) d. (i) e. (iv)

Give one word for the following :

a. Algorithm b. Flowchart e. Decision Box d. Connectors

Chapter- 7 An Introduction of MS Excel 2007
Activity
Page no.- 71

22

Drag and Drop 1 to 5



Complete the following steps :

STEP 1 : Start, STEP 2 : Programs, STEP 3 : Microsoft Office Excel 2007
Activity

Page no. - 78

Give one word for the following :
1. Ctrl + Right Arrow 2. Save As 3. Ctrl + Home 4. Ctrl + end
Assessment

1.

Answer the following questions :

a. Every file that you open in an Excel is called a workbook. Each workbook comes with three
default worksheets. b. The cell with a dark boundary around it is called the active cell. It is also
called the selected cell or the current cell. e. The steps to create a new workbook in Excel are :
Step - 1 Click the Office button. Step - 2 Click the New option from the Office menu. The new
workbook dialog box appears. Step - 3 Click on the Blank and Recent. Step - 4 Select Blank
workbook dialog box. Step - 4 Click on the Create button. d. Title Bar- It appears on the top of
the screen. Title bar displays the name of the current document and current program. It also
contains Minimize, Maximize and Close buttons. Quick Access Toolbar - Next to the Microsoft
office button is Quick Access toolbar. It gives you as access to commands that are frequently used.
Save, Undo, Redo appear on the Quick Access toolbar. Office Button - It contains different
options like New, Save, Open, etc., which helps us to work in MS Excel 2007. Status Bar - It
displays current status of the cells and zoom option. Formula Bar - It shows the cell contents
along with the formulas written for that particular cell. It can also be used to enter data or formula
in a cell. e. A Formula Bar shows the cell contents along with the formulas written for that
particular cell. It can also be used to enter data or formula in a cell.

Fill in the blanks :

a. application b. workbook c. active d. 1048576 e. Formula

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes c. Yes d. No e. No

Match the following columns :

a. (iii) b. (iv) e. (v) d. (i) e. (i)

Name and label the following MS Excel window :

Do it yourself.

Chapter - 8 More on Internet
Activity
Page no. - 83

Write down three uses of Internet :

1. To access information. 2. To get updates 3. To send and receive messages
Activity
Page no. - 90

Do it yourself.

Activity

Page no. - 91

Tick (v') which one is Netiquette?
1.vV2.X3.vV4.X
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Assessment

1.

Answer the following questions :

a. Internet is the biggest network of computers. Many small networks of computers are connected
together to make a global network of computers which has millions of computers in it, building the
Internet. b. Internet was started in 1960 named as ARPANET used for research and development
in defence department of United States of America. c. E-Mail stands for Electronic mail, which is
used for sending and receiving electronic data message to any part of the world. It is excessively
used today. Features of E-mail : (i) E-mail serves accept, forward, deliver and store messages. (ii)
E-Mail is the fastest way of sending and receiving mails. d. E-mail address identifies a user when
we Log in or Sign in on the e-mail. It has three parts : Username or account name, symbol @ (at the
rate), Domain name Password : Password is a unique key that opens e-mail account ID. Without
inputting password, e-mail cannot be opened. The e-mail address is also called E-mail ID. e.
Netiquette are a set of ruled of behaviour when one interacts with people over Internet. A few
rules of Netiquette are : (i) Meet online friends in presence of adult family member. (ii) Avoid
revealing personal information while chatting.

Fill in the blanks

a. Internet b. at the rate ¢. Netiquettes d. Electronic mail e. Delete

Write ‘Yes’ or ‘No’ for the following statements :

a. No b. Yes ¢. No d. No e. No

Match the following columns :

a. (iii) b. (iv) c. (v) d. (i) e. (ii)

Give one word for the following :

a. Netiquettes b. E-mail e. User ID / password d. @ e. Inbox

Model Test Paper

1.b2.a3.a4.¢5.¢6.b7.4a8.a9.b10.b11.¢c12.b13.a14.b15.a16.a17.¢c18.c19.a
20.b
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